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Chapter
 1
About this document

This technical note describes how to troubleshoot problems with the Enterprise 
Vault Reporting feature in an Enterprise Vault 2007 or Enterprise Vault 8.0 
environment.

To troubleshoot problems with the Enterprise Vault Reporting feature in an 
Enterprise Vault 9.0 environment, see the Enterprise Vault 9.0 edition of this 
technical note.

For troubleshooting information on FSA Reporting, see the TechNote on that 
topic at http://entsupport.symantec.com/docs/288460.

What’s in this document
This document contains the following chapters:

■ “Setting up SQL Server Reporting Services” on page 5. Refer to this chapter 
if you have problems with setting up Microsoft SQL Server Reporting 
Services or assigning the Content Manager role to the Vault Service 
account.

■ “Troubleshooting configuration and report deployment” on page 8. Refer to 
this chapter if you had problems when deploying the reports.

■ “Troubleshooting accessing the reports” on page 21. Refer to this chapter if 
the reports deployed successfully but you cannot access them.

■ “Troubleshooting using and exporting reports” on page 33. Refer to this 
chapter if you are having problems with the content of some reports, or 
with exporting the reports to different formats.

http://entsupport.symantec.com/docs/288460
http://entsupport.symantec.com/docs/288460
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Comment on this document
Comment on this document
If any of the information in this document is unclear, or the information you 
were seeking was not provided, please let us know. Your feedback is appreciated, 
and it will help us improve this service.

Please include the following information with your comment:

■ The title and product version of the document you are commenting on

■ The topic (if relevant) you are commenting on

■ Your name

Email your comment to evdocs@symantec.com. Please only use this address to 
comment on product documentation.

mailto:evdocs@symantec.com
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Setting up SQL Server 
Reporting Services

This chapter contains the following sections:

■ “Setting up SQL Server Reporting Services” on page 5

■ “Help with setting up SQL Server 2005 Reporting Services” on page 5

■ “Help with setting up SQL Server 2008 Reporting Services” on page 6

Setting up SQL Server Reporting Services
Enterprise Vault Reporting must be installed on the computer on which you 
install Microsoft SQL Server Reporting Services. See your Enterprise Vault 
documentation and the Enterprise Vault Compatibility Charts for details of the 
supported versions of SQL Server and SQL Server Reporting Services.

As part of preparing for the installation of Enterprise Vault Reporting, you must 
assign the SQL Server Reporting Services Content Manager role to the Vault 
Service account.

If you have problems with setting up SQL Server Reporting Services or assigning 
the Content Manager role, refer to the Microsoft documentation links in the 
appropriate section that follows.

Help with setting up SQL Server 2005 Reporting 
Services

If you have problems with the setting up of Microsoft SQL Server 2005 
Reporting Services, the following links to Microsoft’s SQL Server 
documentation may help.
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Help with setting up SQL Server 2008 Reporting Services
■ Installing and configuring SQL Server 2005 Reporting Services:

http://msdn.microsoft.com/en-us/library/aa545658(CS.70).aspx

■ About Report Manager:

http://msdn.microsoft.com/en-us/library/ms157147(SQL.90).aspx

■ Assigning the Content Manager role to the Vault Service account:

http://msdn.microsoft.com/en-us/library/aa337471(SQL.90).aspx

Help with setting up SQL Server 2008 Reporting 
Services

If you have problems with the setting up of Microsoft SQL Server 2008 
Reporting Services, the following links to Microsoft’s SQL Server 
documentation may help.

■ Installing and configuring SQL Server 2005 Reporting Services:

http://msdn.microsoft.com/en-us/library/ms143736.aspx

■ About Report Manager:

http://msdn.microsoft.com/en-us/library/ms157147.aspx

■ Assigning the Content Manager role to the Vault Service account:

http://msdn.microsoft.com/en-us/library/aa337471.aspx

http://msdn.microsoft.com/en-us/library/aa545658(CS.70).aspx
http://msdn.microsoft.com/en-us/library/ms157147(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/aa337471(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms143736.aspx
http://msdn.microsoft.com/en-us/library/ms157147.aspx
http://msdn.microsoft.com/en-us/library/aa337471.aspx
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Troubleshooting 
configuration and report 
deployment

This chapter contains the following sections:

■ “Troubleshooting configuration and report deployment” on page 8.

■ “Using DTrace with Microsoft SQL Server 2008 Reporting Services” on 
page 8.

■ “Identifying the problem” on page 8.

■ ‘Reporting has been configured on this machine. However, there were a 
few warnings and/or errors...’ message

■ ‘Authentication failed for reporting user’ error message

■ ‘The specified SQL Server does not exist’ error message

■ ‘Ensure that you can browse to the Report Manager...’ error message

■ ‘EnterpriseVaultDirectory database does not exist...’ error message

■ ‘Failed to connect to the specified SQL Server with the credentials you 
provided’ error message

■ ‘Reports failed to deploy successfully’ error message

■ Error code 1 and log file error ‘System Net.Web Exception: Page cannot 
be found’

■ Log file error ‘Assembly security permission grant set’

■ ‘Report deployment failed’ error

■ ‘Couldn’t disable MyReports’ error

■ “Configuring Reporting and deploying the reports” on page 19.



8 Troubleshooting configuration and report deployment
Troubleshooting configuration and report deployment
Troubleshooting configuration and report 
deployment

This chapter describes how to troubleshoot the configuration of Enterprise 
Vault Reporting and the deployment of its reports.

Follow the information in this chapter if, during configuration of the Enterprise 
Vault Reporting feature, or during a subsequent redeployment of the Enterprise 
Vault reports, an error dialog indicates that the configuration or deployment of 
reports has failed.

Using DTrace with Microsoft SQL Server 2008 
Reporting Services

If you use Microsoft SQL Server 2008 Reporting Services, do not attempt to run 
the Enterprise Vault debug utility DTrace on the Reporting Services Report 
Manager process, Reporting ServicesService.exe. Report Manager does not 
render the reports correctly if you enable DTrace on it.

You can use the Microsoft utility DebugView in place of DTrace in this instance. 
You can obtain DebugView from the following location: 
http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx

Identifying the problem
1 Note down any message that is displayed by the configuration process. 

2 Examine the Reporting deployment log file EVDeployReports.Log for any 
error indications. The log file is in the EVReports subfolder of the 
Enterprise Vault installation folder.

Note: If you are running Enterprise Vault 2007 with Service Pack 3 (SP3) or 
later installed, then you can ignore any of the following entries in 
EVDeployReports.Log if they are present, as they do not indicate a problem:
Failed to open registry key - SOFTWARE\Microsoft\Microsoft SQL 
Server\Reporting Services\Version
.
.
An error is encountered when resolving 
hostNameSystem.Net.Sockets.SocketException: No such host is 
known
   at System.Net.Dns.GetAddrInfo(String name)
   at System.Net.Dns.InternalGetHostByName(String hostName, 
Boolean includeIPv6)

http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx
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   at System.Net.Dns.GetHostEntry(String hostNameOrAddress)
   at Symantec.EnterpriseVault.Reporting.UIHelper.
FullyQualifiedDomainName(String domainName)
Unable to find Fully Qualified Domain Name for : domain_name
.
.
Entered ReportDeployForm::DeployReportsCallback
Entered Configuration::Configuration()
Invalid command line arguments are passed
Leaving ReportDeployForm::DeployReportsCallback

3 Follow the appropriate instructions below to resolve the problem.

‘Reporting has been configured on this machine. However, there 
were a few warnings and/or errors...’ message

Enterprise Vault version: Enterprise Vault 8.0 with SP1 or later installed.

Symptoms: The Reporting Configuration utility displays the following message:
Reporting has been configured on this machine. However, there were a 
few warnings and/or errors, as a result of which some reports may 
not work. For details, see the log file EVDeployReports.Log in the 
EVReports subfolder of the Enterprise Vault installation folder.

Cause: The configuration was successful, but Enterprise Vault noted one or 
more of the following conditions:

■ Enterprise Vault auditing is not configured.

■ FSA Reporting is not configured.

To determine the cause of the message, examine EVDeployReports.Log. 

Resolution: Some of Enterprise Vault Reporting’s reports require Enterprise 
Vault auditing as a prerequisite. Other reports require FSA Reporting as a 
prerequisite. Read the following sections and configure one or both of these 
features, if you require them. 

About Enterprise Vault auditing
The two Enterprise Vault Reporting Operation reports Archived Items Access 
and Archived Items Access Trends require auditing to be configured for the 
Enterprise Vault server. If you do not intend to run either of these reports, you 
do not need to configure auditing.

You must enable auditing to create the auditing database, and then configure 
the auditing level for the required auditing categories in the properties of the 
Enterprise Vault server. 
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Identifying the problem
For more information on enabling and configuring auditing for Enterprise 
Vault, see the Administrator’s Guide.

About FSA Reporting
Enterprise Vault Reporting’s Data Analysis reports require FSA Reporting to be 
configured. The Data Analysis reports do not show data for a file server or a 
volume until FSA Reporting has performed a successful scan on that file server 
or volume.

If you do not want to run the Data Analysis reports, you do not need to configure 
FSA Reporting.

For information on configuring FSA Reporting and running a scan, see the 
Administrator’s Guide. (From Enterprise Vault 8.0 SP2, see the Reporting guide.)

‘Authentication failed for reporting user’ error message
Enterprise Vault version: Any version.

Symptoms: The Reporting Configuration utility displays a “Validation Error” or 
“Error in Prerequisites” dialog with the message: 

Authentication failed for reporting user

Cause: There is a problem with the Reporting user account credentials you 
entered.

Resolution: To resolve this problem:

1 Ensure you are supplying the correct user name and password for the 
Reporting user account.

2 Ensure you can ping the domain specified in the credentials.

3 Rerun the Reporting Configuration utility with the “Configure Reporting 
and deploy or upgrade reports” option. When specifying the domain, try 
providing a fully qualified domain name (FQDN).

See “Configuring Reporting and deploying the reports” on page 19.

‘The specified SQL Server does not exist’ error message
Enterprise Vault version: Enterprise Vault 8.0 with SP1 or later installed.

Symptoms: The Reporting Configuration utility displays the following error 
message:
The Specified SQLServer does not exist.

Cause: This message appears if you enter an invalid SQL Server name.
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Identifying the problem
Resolution: Rerun the Reporting Configuration utility with the “Configure 
Reporting and deploy or upgrade reports” option. Enter the correct name for the 
SQL Server.

See “Configuring Reporting and deploying the reports” on page 19.

‘Ensure that you can browse to the Report Manager...’ error message
Enterprise Vault version: Enterprise Vault 8.0 with SP1 or later installed.

Symptoms: The Reporting Configuration utility displays the following error 
message:
Ensure that you can browse to the Report Manager Web application and 
view its Home page successfully. The URL has the format 
http://host_name/webapp_name/, for example 
http://myserver.mydomain.com/Reports/. When you have displayed the 
Report Manager Home page, click ‘OK’ below to continue.

Cause: This message appears if the Configuration utility is unable to access the 
Microsoft Reporting Services Report Manager Web application.

Resolution: Make sure that the Microsoft SQL Server Reporting Services are 
configured and running.

Then follow the error dialog instructions to browse to the Report Manager Web 
application’s home page. When you have successfully accessed the Web 
application home page, click “OK” on the error dialog to continue the 
configuration.

If the same error dialog reappears when you click “OK”, refresh the Report 
Manager home page and then click “OK” on the dialog again. On a slow Report 
Server you may need to repeat these actions a number of times until the error 
dialog no longer appears and the reports deploy successfully.

‘EnterpriseVaultDirectory database does not exist...’ error message
Enterprise Vault version: Enterprise Vault 8.0 with SP1 or later installed.

Symptoms: The Reporting Configuration utility displays the following error 
message:
‘EnterpriseVaultDirectory’ database does not exist on the specified 
SQL server.

Cause: This message appears if the Configuration utility fails to detect the 
Enterprise Vault Directory database on the specified SQL Server.

Resolution: Rerun the Reporting Configuration utility with the “Configure 
Reporting and deploy or upgrade reports” option. Enter the name for the SQL 
Server that contains the Enterprise Vault Directory database.

See “Configuring Reporting and deploying the reports” on page 19.
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‘Failed to connect to the specified SQL Server with the credentials 
you provided’ error message

Enterprise Vault version: Enterprise Vault 8.0 with SP1 or later installed.

Symptoms: The Reporting Configuration utility displays the following error 
message:
Failed to connect to the specified SQL Server with the credentials 
you provided.

Cause: This message appears if the utility is unable to connect to the SQL Server 
with the credentials of the account that you are logged in with.

Resolution: Make sure that the Vault Service account that you are using can 
connect from the Reporting Services computer to the SQL Server that you 
specified. Then rerun the Reporting Configuration utility with the “Configure 
Reporting and deploy or upgrade reports” option.

See “Configuring Reporting and deploying the reports” on page 19.

‘Reports failed to deploy successfully’ error message
Enterprise Vault version: Enterprise Vault 2007 with Service Pack 3 (SP3) or 
later installed.

Symptoms: The Reporting Configuration utility displays the following error 
message:
The reports failed to deploy successfully: see EVdeployreports.log 
in the EVReports subfolder of the EV installation folder for more 
details.

Note: If you get this message, run the Enterprise Vault reports that you intend to 
use. If the reports contain data, then you can ignore the message.
Remember that the Data Analysis reports do not show data for a file server or a 
volume until FSA Reporting has performed a successful scan on that file server 
or volume. For information on configuring FSA Reporting and running a scan, 
see the Administrator’s Guide. (From Enterprise Vault 8.0 SP2, see the Reporting 
guide.)

Cause: One of the following problems may have occurred during the report 
deployment:

■ A SQLException occurred when the Reporting Configuration utility 
attempted to do any of the following:

■ Add the Reporting user account to the Enterprise Vault databases.

■ Create the role ‘EVReportingRole’ on the auditing database.

■ Grant ‘SELECT’ access permissions to the EVReportingRole.
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■ The Reporting Configuration utility was unable to set access for the 
Reporting user on the Report Server’s bin folder.

Resolution: If you run all the Enterprise Vault reports you intend to use and they 
contain data, you can ignore the ‘Reports failed to deploy successfully’ message.

If any of the reports do not contain data, work through the following steps:

1 A likely reason for the ‘Reports failed to deploy successfully’ message is the 
absence of an auditing database or an FSA Reporting database. These 
databases are required for some of Enterprise Vault Reporting’s reports:

■ The auditing database is required for two of the Operation reports, 
‘Archived Items Access’ and ‘Archived Items Access Trends’. If the 
auditing database is absent, you will see entries similar to the following 
in EVDeployReports.Log:
EnterpriseVaultAuditDb is not configured

Database: EnterpriseVaultAudit, SQL Server: MyServer
Error connecting

Note: If you do not want to use the archived items access reports, you 
can ignore these log entries.

If you want to use the ‘Archived Items Access’ and ‘Archived Items 
Access Trends’ reports, you must enable Enterprise Vault auditing. 

For information on enabling Enterprise Vault auditing, see the 
Administrator’s Guide.

■ The FSA Reporting database is required for all the Data Analysis 
reports. If the FSA Reporting database is absent, you will see entries 
similar to the following in EVDeployReports.Log:
EnterpriseVaultFSAReportingDb is not configured

Database: EnterpriseVaultFSAReporting, SQL Server: MyServer
Error connecting

Note: If you do not want to use the Data Analysis reports, you can 
ignore these log entries.

If you want to use the Data Analysis reports, you must configure FSA 
Reporting.

For information on configuring FSA Reporting, see the Administrator’s 
Guide. (From Enterprise Vault 8.0 SP2, see the Reporting guide.)

If EVDeployReports.Log indicates another problem, work through the rest 
of the steps below. For a list of entries in the log that you can ignore, see 
“Identifying the problem” on page 8.
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2 Ensure that a SQL Server login for the Reporting user account is present on 
the SQL servers used for the Enterprise Vault Directory database, all Vault 
store databases, and the Enterprise Vault Monitoring database.

3 Ensure that the “EVReportingRole” role has been assigned to the Reporting 
user SQL Server login on all Enterprise Vault databases.

4 Ensure that, for each database listed in Table 3-1, the “EVReportingRole” 
role has been granted “SELECT” access permission for the specified views.

Table 3-1 Enterprise Vault database views required by Reporting

Database View

EnterpriseVaultAudit EVAuditView

EnterpriseVaultDirectory ArchiveView 

ComputerServiceTypeView

VaultEntryView

view_ComputerEntry

view_ComputerTask

view_DominoMailboxArchivingStatus

view_ExchangeMailboxArchivingStatus

view_ExchangeMailbox_Server

view_ExchangeServerEntry

view_MonitoringSettings

view_NotesJournal_Server_Domain

view_NotesMailServerEntry

view_NotesMailServer_Domain

view_NotesMailboxArchivingStatus

view_PartitionEntry

view_PolicyTargetGroup_PolicyEntry

view_Root

view_Site

view_Storage_VaultStoreEntry

view_Trustee
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5 Ensure that the Reporting user has been granted “log on locally” rights on 
the Reporting Services Report Server computer.

6 Ensure the Reporting user has “full control” access rights on the folder 
<Reporting_Services_install_folder>/ReportServer/bin.

7 Try accessing the reports. If you continue to have problems, see 
“Troubleshooting accessing the reports” on page 21, and “Troubleshooting 
using and exporting reports” on page 33.

Error code 1 and log file error ‘System Net.Web Exception: Page 
cannot be found’

Symptoms: The Reporting Configuration utility displays an error message with 
error code 1 and the message:
Error: Report Deployment Failed. Miscellaneous error.

In addition, the following error message appears in EVDeployReports.Log:
System Net.Web Exception: The request failed with HTTP status 404: 
Page cannot be found

Cause: Enterprise Vault could not access the Report Server in order to deploy 
the reports, due to firewall or trusted site settings.

Resolution: To resolve this problem:

EnterpriseVaultMonitoring JrnMailBoxParametersView

MailboxParameterConfigView

view_DominoJrnMailBoxParameters

view_MailboxMonitoringHistory

view_ServiceMonitoringHistory

view_TaskMonitoringHistory

Vault Store database(s) view_Collection

view_ListVaults

view_SaveSet

view_Saveset_Archive_Vault

view_Saveset_Properties

view_VaultStoreSummary

Table 3-1 Enterprise Vault database views required by Reporting

Database View



16 Troubleshooting configuration and report deployment
Identifying the problem
1 On the Report Server machine, open Internet Explorer, select Tools > 
Internet Options, and select the Connections tab.

2 Click LAN Settings and, in the Proxy server area, clear the Use a Proxy 
Server for LAN check box.

3 Click OK and then click OK again to exit the dialogs.

4 Again from Internet Explorer select Tools > Internet Options and select the 
Security tab.

5 Select the Local intranet Web content zone. Then, in the Local intranet 
area, click Sites to display the Local intranet dialog.

6 Click the Advanced button and add the URL for the Report Server to the list 
of Web sites in this zone. The Report Server URL is as follows:

http://<host_name>/<report_server_name>/

where:

■ <host_name> is the fully qualified host name of the computer hosting 
the Microsoft SQL Server Reporting Services Report Server.

■ <report_server_name> is the name of the Report Server.

For example:

http://myserver.evdomain.com/ReportServer

or: 

http://myserver.evdomain.com/ReportServer$MyInstance

where MyInstance is the Reporting Services instance name.

You can obtain this URL from the RSReportServer.config file, if you wish. 
This file is present in the parent folder of the bin folder where the reports 
are to be installed. Typically this is:

■ For SQL Server 2000 Reporting Services: 

C:\Program Files\Microsoft SQL 
Server\MSSQL\Reporting Services\ReportServer

■ For SQL Server 2005 Reporting Services: 

C:\Program Files\Microsoft SQL 
Server\MSSQL.2\Reporting Services\ReportServer

where MSSQL.2 is the instance where you intend to deploy the reports.

7 Click Close or OK and then OK to close the Local intranet dialogs. Then click 
OK to exit the Internet Options dialog.

8 Rerun the Reporting Configuration utility with the Configure Reporting and 
deploy or upgrade reports option. See “Configuring Reporting and 
deploying the reports” on page 19.
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Log file error ‘Assembly security permission grant set’
Symptoms: The Reporting Configuration utility displays the error message: 

Error: Report Deployment Failed

and EVDeployReports.Log contains the following error message:

Assembly AssemblyName security permission grant set is 
incompatible between app domains

Cause: This problem is described in detail in the Microsoft Knowledge Base 
article http://support.microsoft.com/?kbid=822526&FR=1.

Resolution: To resolve this problem:

1 Restart the IIS Admin service.

2 Rerun the Reporting Configuration utility with the Configure Reporting and 
deploy or upgrade reports option. See “Configuring Reporting and 
deploying the reports” on page 19.

‘Report deployment failed’ error
Enterprise Vault version: This problem can appear on systems that have not 
been upgraded to Enterprise Vault 2007 Service Pack 2 (SP2) or later. 
Symptoms: The Reporting Configuration utility displays a “Deployment Error” 
dialog with the message: 

Report deployment failed. Restart IIS and run the Enterprise Vault 
Reporting Configuration utility again. Please refer to the 
EVDeployReports.log file and to the ‘Troubleshooting Enterprise 
Vault Reporting’ TechNote for more details.

In addition, EVDeployReports.Log contains an exception beginning as follows:
Entered RsHelper::ListReportServerItems() 
System.Web.Services.Protocols.SoapException:System.Web.Services.Pro
tocols.SoapException: The value for parameter 'Item' is not 
specified. It is either missing from the function call, or it is set 
to null. ---> 
Microsoft.ReportingServices.Diagnostics.Utilities.MissingParameterE
xception: The value for parameter 'Item' is not specified. It is 
either missing from the function call, or it is set to null.

Cause: The problem may occur if you have selected the following Microsoft SQL 
Server Reporting Services setting to create a “My Reports” folder for each user:

Enable My Reports to support user-owned folders for publishing and 
running personalized reports

This setting appears on the Reporting Services Report Manager’s Site Settings 
page:

http://support.microsoft.com/?kbid=822526&FR=1
http://support.microsoft.com/?kbid=822526&FR=1
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Figure 3-1 Report Manager Site Settings page

Resolution: Clear the ‘Enable My Reports...’ setting on the Site Settings page 
temporarily while you deploy the reports, as follows:

1 In your Web browser, enter the URL for the SQL Server Reporting Services 
Report Manager Web application. The URL has the following format:
http://host_name/reportmgr_Webapp_name/ 

where:

■ host_name is the fully qualified host name of the computer hosting 
the Microsoft SQL Server Reporting Services Report Manager Web 
application

■ reportmgr_Webapp_name is the name of the Microsoft SQL Server 
Reporting Services Report Manager Web application. 

For example:
http://myserver.evdomain.com/Reports/

2 On the Report Manager Home page, click Site Settings.

3 On the Site Settings page, clear the ‘Enable My Reports...’ setting, and click 
Apply to save the change.

4 Run the Enterprise Vault Reporting Configuration utility to deploy the 
Enterprise Vault reports.

See “Configuring Reporting and deploying the reports” on page 19.

5 Restore the ‘Enable My Reports...’ setting on the Report Manager’s Site 
Settings page and click Apply to save the change.
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‘Couldn’t disable MyReports’ error
Enterprise Vault version: This problem can appear on systems with Enterprise 
Vault 2007 Service Pack 2 (SP2) or later installed, or on Enterprise Vault 8.0. 

Symptoms: The Reporting Configuration utility displays a dialog with the 
following message: 

Couldn't disable MyReports. Please disable My Reports in 
SiteSettings of Report Manager and Click OK. Please see help for 
details.

Cause: The problem may occur if you have selected the following Microsoft SQL 
Server Reporting Services setting to create a “My Reports” folder for each user:

Enable My Reports to support user-owned folders for publishing and 
running personalized reports

Enterprise Vault normally clears the setting temporarily while it deploys the 
reports. However, if you receive this error, Enterprise Vault has been unable to 
clear the setting.

Resolution: Clear the ‘Enable My Reports...’ setting manually while you deploy 
the reports. To do this, follow the resolution described for the previous problem.

See “‘Report deployment failed’ error” on page 17.

Configuring Reporting and deploying the reports
You can configure Enterprise Vault Reporting and deploy its reports using the 
Enterprise Vault Reporting Configuration utility. If the configuration fails for 
some reason, you can rectify the error and then re-run the Reporting 
Configuration utility with the Configure Reporting and deploy or upgrade 
reports option.

To configure Reporting and deploy reports

1 On the Windows Start menu, click Programs > Enterprise Vault > 
Enterprise Vault Reports Configuration.

2 On the Reporting Configuration utility dialog:

■ Select Configure Reporting and deploy or upgrade reports.

■ Enter the Domain, User name and Password for the Reporting user 
account.

■ If you are using Microsoft SQL Server 2005 or 2008 Reporting Services, 
re-enter the SQL Reporting Services Instance.

■ Specify the Language in which to deploy the reports.

■ Specify the name of the Directory database SQL Server.

3 Click Configure to deploy the reports.
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Troubleshooting accessing 
the reports

This chapter contains the following sections:

■ Troubleshooting accessing the reports

■ Unable to view the reports

■ Error message ‘An error has occurred during report processing’ with SQL 
Server 2008 Reporting Services

■ Access to reports denied with SQL Server 2000 Reporting Services

■ Access to reports denied for local administrator

■ Vault Service account unable to access reports

■ Unable to access Report Server from a different domain

■ Unable to access Enterprise Vault reports from a different domain

■ Unable to access Report Manager on a 64-bit Windows system due to a 
permissions issue

■ Problems after upgrading to SQL Server 2005 Reporting Services

■ Changing the Reporting user account details

Troubleshooting accessing the reports
This chapter describes how to troubleshoot problems with accessing Enterprise 
Vault Reporting’s reports.

Note: This chapter assumes you have successfully deployed Enterprise Vault 
Reporting’s reports.
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Unable to view the reports
If you are having general problems logging in or getting reports to display 
successfully, follow this checklist:

■ Confirm that the Enterprise Vault Reporting prerequisites have been 
satisfied: 

■ Microsoft SQL Server 2000 Reporting Services with SP2; or Microsoft 
SQL Server 2005 Reporting Services (SP1 or later recommended). 
From Enterprise Vault 8.0 SP2, Microsoft SQL Server 2008 Reporting 
Services (with SP1) is also supported. See the Enterprise Vault 
Compatibility Charts for the latest information on supported versions 
of SQL Server Reporting Services.

■ Microsoft .NET Framework v 2.0 and .NET Framework v1.1 both 
installed.

■ IIS registered with ASP.NET 1.1 for SQL Server 2000 Reporting 
Services SP2; or with ASP.NET 2.0 for SQL Server 2005 Reporting 
Services.

■ A network connection to the computer or computers hosting the 
Enterprise Vault databases.

■ Verify that IIS is not locked down, and that IIS services are not stopped. Try 
stopping and restarting IIS.

■ Access the SQL Server Reporting Services Report Manager Web application 
with an account that is assigned to a suitable role:

■ For Enterprise Vault 2007 and its service packs, provide the credentials 
of an account that has been assigned a “Browser” role in Microsoft SQL 
Server Reporting Services. Refer to your Microsoft Reporting Services 
documentation for instructions on how to do this.

■ For Enterprise Vault 8.0 and its service packs, provide the credentials 
of an account that has been assigned to an Enterprise Vault 
administrator role with access to the required reports. See the section 
“Roles and Enterprise Vault Reporting” in the chapter “Managing 
Administrator Security” in the Administrator’s Guide. (From 
Enterprise Vault 8.0 SP2, see also the Reporting guide.)

■ Ensure that a SQL Server login for the Reporting user account you created 
in the pre-installation steps is present on all the SQL servers used for the 
Enterprise Vault Directory database, all Vault store databases, and the 
Monitoring database.

■ Ensure that the “EVReportingRole” role has been assigned to the Reporting 
user SQL Server login on all Enterprise Vault databases.
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■ Ensure that, for each database listed in Table 4-1, the “EVReportingRole” 
role has been granted “SELECT” access permission for the specified views.

Table 4-1 Enterprise Vault database views required by Reporting

Database View

EnterpriseVaultAudit EVAuditView

EnterpriseVaultDirectory ArchiveView 

ComputerServiceTypeView

VaultEntryView

view_ComputerEntry

view_ComputerTask

view_DominoMailboxArchivingStatus

view_ExchangeMailboxArchivingStatus

view_ExchangeMailbox_Server

view_ExchangeServerEntry

view_MonitoringSettings

view_NotesJournal_Server_Domain

view_NotesMailServerEntry

view_NotesMailServer_Domain

view_NotesMailboxArchivingStatus

view_PartitionEntry

view_PolicyTargetGroup_PolicyEntry

view_Root

view_Site

view_Storage_VaultStoreEntry

view_Trustee

EnterpriseVaultMonitoring JrnMailBoxParametersView

MailboxParameterConfigView

view_DominoJrnMailBoxParameters

view_MailboxMonitoringHistory
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■ Check whether the Reporting user account password has expired. Ideally 
this password should have been set never to expire, as described in the 
Installing and Configuring manual. However, if the account password has 
expired, you must change the Reporting user account credentials. Follow 
the instructions in “Changing the Reporting user account details” on 
page 29.

Error message ‘An error has occurred during report 
processing’ with SQL Server 2008 Reporting 
Services

Affected configurations: Microsoft SQL Server 2008 Reporting Services.

Problem: When SQL Server 2008 Reporting Services Report Manager renders a 
report it displays the following message:

An error has occurred during report processing. 
(rsProcessingAborted)

The Value expression for the query parameter 
‘@SearchResult’ contains an error: Index was outside the 

bounds of the array. (rsRuntimeErrorInExpression)

Cause: This error message appears if there is no data available to display for the 
report. This is a known issue with Microsoft SQL Server 2008 Reporting 
Services. The issue is described on the following Microsoft Connect page:

http://connect.microsoft.com/SQLServer/feedback/ViewFeedback.aspx?Feedba
ckID=416371

view_ServiceMonitoringHistory

view_TaskMonitoringHistory

Vault Store database(s) view_Collection

view_ListVaults

view_SaveSet

view_Saveset_Archive_Vault

view_Saveset_Properties

view_VaultStoreSummary

Table 4-1 Enterprise Vault database views required by Reporting

Database View

http://connect.microsoft.com/SQLServer/feedback/ViewFeedback.aspx?FeedbackID=41637
http://connect.microsoft.com/SQLServer/feedback/ViewFeedback.aspx?FeedbackID=41637
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Resolution: Wait until Enterprise Vault Reporting has completed a successful 
data scan and then re-run the report. 

Ensure that Enterprise Vault is gathering data for the report. Note that with 
Enterprise Vault 8.0 SP2 and later, FSA Reporting does not gather data by 
default for the duplicate files reports. For more information, see the Reporting 
guide.

Access to reports denied with SQL Server 2000 
Reporting Services

Affected configurations: Enterprise Vault 8.0 with Service Pack 1, Microsoft 
SQL Server 2000 Reporting Services.

Problem: You are denied permission to access any reports on a SQL Server 
running SQL Server 2000 Reporting Services, despite your account being in one 
of the Enterprise Vault administrator roles.

Cause: SQL Server 2000 Reporting Services may under rare circumstances deny 
access to users who do not belong to the Windows Administrators Group.

Resolution: If this problem occurs, make sure that the user account is in the 
Windows Administrators group.

Access to reports denied for local administrator
Affected configurations: Microsoft SQL Server 2000 Reporting Services.

Problem: If you access the reports as follows and attempt to run a report, an 
error that states that the account does not have access to the reports:

■ You log on locally to the Microsoft SQL Server 2000 Reporting Services 
computer, with the credentials of an account in the local administrators 
group, other than the Vault Service account.

■ You then access the Report Manager Web application by specifying:

■ The fully qualified host name or IP address in the URL for the Report 
Manager Web application. 

■ The credentials of the Vault Service account or an account other than 
the local administrator account with which you logged on to the 
computer.

Cause: There is a permissions issue.

Resolution: To work around this problem, do either of the following:

■ Log on to the local computer with the Vault Service account or with an 
account that is assigned to a role that allows access to the Enterprise Vault 
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reports. (See “Access the Reporting Web application with an account that is 
assigned to a suitable role” in “Unable to view the reports” on page 22.) 
Then specify the same account in Internet Explorer when you access the 
Report Manager Web application.

■ Or use the following method to run Internet Explorer using a suitable 
account:

■ Click Start > Programs.

■ Right-click Internet Explorer and from the shortcut menu select Run 
As.

■ Specify the Vault Service account or an account that is assigned to a 
suitable role.

Vault Service account unable to access reports
Affected configurations: Enterprise Vault 8.0 with Service Pack 1.

Problem: Under some circumstances the Vault Service account may receive an 
“access denied” error when attempting to access the reports. This may occur if 
you use a fully qualified domain name or an IP address in the URL for the Report 
Manager Web application.

Workaround: To access the reports, use the following URL from the computer on 
which the reports are deployed:

http://localhost/Reports/

Unable to access Report Server from a different 
domain

Affected configurations: Microsoft SQL Server 2000 Reporting Services.

Problem: You cannot access the SQL Server Reporting Services Report Server 
from a different domain to that in which the Report Server is located.

Cause: The registry and the Reporting Services configuration files require the 
fully qualified domain name of the Report Server.

Resolution: To resolve this problem, do as follows:

1 Navigate to the following Registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 
Server\80\Reporting Services

2 Change the values of RSVirtualDir and WAVirtualDir under this key. These 
entries have the following values:

■ RSVirtualDir: http://<server>/ReportServer
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■ WAVirtualDir: http://<server>/Reports

In each case, replace <server> with the fully qualified domain name of the 
server.

3 Add a host name entry on your internal DNS server and, if external access is 
required, on your external DNS server.

4 Edit both of the following configuration files on your Report Server:

■ <SQL_Server_Install_Path>\Reporting 
Services\ReportServer\RSReportServer.config

■ <SQL_Server_Install_Path>\Reporting 
Services\ReportManager\RSWebApplication.config

These files both contain one reference to the ReportServer URL that is 
referenced RSVirtualDir in step 2. In both cases, edit the URL to replace the 
server name with its fully qualified domain name.

5 Restart the ReportServer service.

Unable to access Enterprise Vault reports from a 
different domain

Affected configurations: All configurations.

Problem: You cannot browse to the Symantec EnterpriseVault folder from the 
Report Manager Home page when you access the Report Server from a computer 
in a different domain. Internet Explorer repeatedly prompts you for login 
credentials, which it does not accept.

Cause: There is an issue with Internet Explorer’s security settings.

Resolution: To resolve this problem, do as follows:

1 In Internet Explorer, select Tools > Internet Options.

2 Click the Advanced tab, and under Security, uncheck the setting Check for 
signatures on downloaded programs.

3 Restart Internet Explorer.

Unable to access Report Manager on a 64-bit 
Windows system due to a permissions issue

Affected configurations: Report Manager running on a 64-bit Windows system.

Problem: After the deployment of Enterprise Vault Reporting’s reports, Report 
Manager fails to open. SQL Server Reporting Services displays an Error page 
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which states that the permissions granted to your user account are insufficient 
for performing this operation.

Cause: A possible cause is that the EvAzStore.xml file is not up-to-date.

Resolution: Check the time stamp of the EvAzStore.xml file and if necessary, 
manually register azroles.dll, as follows:

1 On the computer on which SQL Server Reporting Services is installed, 
browse to the ReportServer\bin folder under Program Files\Microsoft SQL 
Server.

2 Find the file EvAzStore.xml and examine its “Date Modified” time stamp. If 
the time stamp indicates a date and time that is before the time that you 
first attempted to access Report Manager’s home page after deploying the 
Enterprise Vault reports, then manually register the Microsoft dll file 
azroles.dll as follows:

a Open Windows Control Panel, select Administrative Tools and then 
select Microsoft .NET Framework 2.0 Configuration. 

b In the left pane of the .NET Framework 2.0 Configuration utility, 
expand My Computer, right-click Assembly Cache and choose Add.

c Browse to the following folder:
WINDOWS\Microsoft.NET\AuthMan\1.2

d Select the file microsoft.interop.security.azroles.dll 
and click Open to add this assembly.

e Close the .NET Framework 2.0 Configuration utility.

f Open the Services snap-in to the Microsoft Management Console, and 
restart the IIS Admin Service and the SQL Server Reporting Services.

Problems after upgrading to SQL Server 2005 
Reporting Services

Problem: After upgrading from SQL Server 2000 Reporting Services to SQL 
Server 2005 Reporting Services, you see the following message when running a 
report:

An error has occurred during report processing (rsProcessingAborted)

An attempt has been made to use a data extension 'EVDataExtension' 
that is not registered for this report server. 
(rsDataExtensionNotFound)

Cause: The SQL Server 2005 Reporting Services Report Server web.config file 
does not have redirection for the Microsoft.ReportingServices.Interfaces dll.

Resolution: To resolve this problem, do as follows:
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1 Open the ReportServer folder in the Microsoft SQL Server Reporting 
Services installation folder.

2 Make a backup copy of the web.config file.

3 Open the web.config file for editing using a text editor such as Notepad.

4 Add the following subnode within the <runtime> node:

<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">

<dependentAssembly>

<assemblyIdentity name="Microsoft.ReportingServices.Interfaces"

publicKeyToken="89845dcd8080cc91"

culture="neutral" />

<bindingRedirect oldVersion="8.0.242.0"

newVersion="9.0.242.0"/>

</dependentAssembly>

</assemblyBinding>

5 Save the changes to the web.config file.

Changing the Reporting user account details
Enterprise Vault Reporting requires an Active Directory user account to use 
when accessing the Enterprise Vault databases. If you want Enterprise Vault 
Reporting to use a different user account, or if the existing account password 
expires, you can change the credentials of the account in either of the following 
ways:

■ From the Enterprise Vault Reporting Configuration utility.

See “To change the Reporting user account credentials using the Reporting 
Configuration utility” on page 29.

■ By manually updating the account’s credentials in the shared data source 
on the Reporting Services Report Server, and then assigning the required 
role and rights to the new account.

See “To change the Reporting user account credentials manually” on 
page 30.

To change the Reporting user account credentials using the Reporting 
Configuration utility

1 If you require a new Windows user account, create the replacement account 
in the Active Directory domain. This account does not require a mailbox, 
and need not be a member of the Windows Administrators group. When you 
create the account:
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■ Select the Password Never Expires option

■ Leave the remaining check boxes clear (User Must Change Password at 
Logon, Use Cannot Change Password, Account is Disabled).

2 On the Windows Start menu, click Programs > Enterprise Vault > 
Enterprise Vault Reports Configuration.

3 On the Reporting Configuration utility dialog:

■ Select Reconfigure data access settings for Reporting. 

■ Enter the Domain, User name and Password for the new or modified 
Reporting user account.

■ If you are using SQL Server 2005 Reporting Services, re-enter the SQL 
Reporting Services Instance.

■ Specify the name of the Directory database SQL Server.

■ Click Reconfigure to configure the new Reporting user account.

To change the Reporting user account credentials manually

1 If you require a new Windows user account, create the replacement account 
in the Active Directory domain. This account does not require a mailbox, 
and need not be a member of the Windows Administrators group. When you 
create the account:

■ Select the Password Never Expires option

■ Leave the remaining check boxes clear (User Must Change Password at 
Logon, Use Cannot Change Password, Account is Disabled).

2 Go to the Report Manager Web application, for example 
http://<host_name>/reports

3 Log in with an account that has a “content manager” role on the Report 
Server.

4 Click the Symantec Enterprise Vault link.

5 Click Show Details.

6 Click the EnterpriseVaultDS link.

7 In Connect using, select Credentials stored securely in the report server. 
Then set the new user name and password and click Apply.

8 Close the Report Manager Web application.

9 Assign the EVReportingRole role to the new Reporting user on all 
Enterprise Vault databases, including the Monitoring database, 
EnterpriseVaultMonitoring, and the Auditing database, 
EnterpriseVaultAudit, if it has been configured.
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10 Grant the “log on locally” right to the new Reporting user on the Reporting 
Services Report Server machine.

11 Ensure the new Reporting user has “full control” access rights on the folder 
<Reporting_Services_install_folder>/ReportServer/bin.
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Chapter
 5
Troubleshooting using and 
exporting the reports

This chapter contains the following sections:

■ Troubleshooting using and exporting reports

■ Troubleshooting problems with report content

■ Troubleshooting report export

■ Using Reporting with multiple Reporting Services

Troubleshooting using and exporting reports
This chapter describes how to troubleshoot problems with the content and 
export of Enterprise Vault Reporting’s reports.

Note: This chapter assumes you have successfully deployed the Enterprise Vault 
Reporting reports and can access them successfully.

Troubleshooting problems with report content
This section describes how to troubleshoot problems that affect the content of 
the Enterprise Vault reports.

Note: The problem may be seen in all supported Microsoft Reporting Services 
configurations, unless a specific configuration is quoted.
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Images or data fail to appear
Problem: Data and images are omitted from a report when you first run it.

Cause: This problem can occur on the first occasion that you run a report, if the 
Microsoft Reporting Services Report Server’s name contains special characters 
such as a hyphen or underscore.

Resolution: To work around this problem, run the report and then click the 
Refresh button on the Report Manager toolbar (located below the parameter 
value entry boxes). The images and data should display correctly in the 
refreshed screen.

Reports omit data related to some vault stores
Problem: Reports omit data from some vault stores.

Cause: You have not set up the Reporting user account’s access roles correctly.

Resolution: Ensure that the Reporting user account is assigned the 
“EVReportingRole” role on the vault store SQL server.

No information appears in the Data Analysis reports
Problem: The Data Analysis Reports contain no data.

Cause: These reports require Enterprise Vault FSA Reporting to be configured, 
and to have completed a successful scan of the file server or volume.

Resolution: Configure FSA Reporting from the Enterprise Vault Administration 
Console and ensure that FSA Reporting has performed a successful scan. For 
instructions, see the Administrator’s Guide. (From Enterprise Vault 8.0 SP2, see 
the Reporting guide.)

No information appears in reports that use Monitoring data
Problem: The following Operation Reports contain no data:

■ Domino Server Journal Mailbox Archiving Health

■ Domino Server Journal Mailbox Archiving Trends

■ Enterprise Vault server 24-hour Health Status

■ Enterprise Vault server Seven-day Health Status

■ Exchange Server Journal Mailbox Archiving Health

■ Exchange Server Journal Mailbox Archiving Trends

Cause: These reports rely on information gathered by the Enterprise Vault 
Monitoring agents. They contain no data if Enterprise Vault server Monitoring 
is disabled, or if there is a problem with the Monitoring agents.
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Resolution: Enable Monitoring from Enterprise Vault Operations Manager. For 
instructions, see the Operations Manager online help or the Administrator’s 
Guide.

If server Monitoring is enabled but the reports are still not displaying data, it is 
possible that there is a problem with the Monitoring agents. Follow the 
instructions for troubleshooting the Monitoring agents in the following 
document on the Enterprise Vault Support Web site: 
http://entsupport.symantec.com/docs/287449.

No information appears in reports that use auditing data
Problem: The following Operation Reports contain no data:

■ Archived Items Access

■ Archived Items Access Trends

Cause: These reports rely on information obtained from the Enterprise Vault 
auditing database. They contain no data if Enterprise Vault auditing is disabled.

Resolution: Enable Enterprise Vault auditing from the Enterprise Vault 
Administration Console. For instructions, see the Administrator’s Guide.

Mailbox Archiving Status report: Error when changing sort option
Problem: Changing the sort option on the Mailbox Archiving Status report 
results in the error:
This operation is not supported for reports that are 
configured to run as report execution snapshots 
(rsReportSnapshotEnabled)

Affected configurations: Microsoft SQL Server 2005 Reporting Services.

Cause: You may receive this error if you have configured the report to use the 
“Render this report from an execution snapshot” option. Microsoft Reporting 
Services has issues with interactive sorting when executed with this option. 

Resolution: This issue is fixed in Microsoft SQL Server 2005 SP1.

Domino Server Journal Mailbox Archiving Health report: Unable to 
distinguish between Domino journal mailbox locations

Problem: If an Enterprise Vault server archives from multiple Domino servers 
containing Domino journal mailbox locations with the same name, such as 
symantec\*, then when viewing the Domino Server Journal Mailbox Archiving 
Health report, you cannot identify the Domino server to which a journal mailbox 
location belongs.

http://entsupport.symantec.com/docs/287449
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Cause: The report does not identify the Domino server to which a journal 
mailbox location belongs.

Resolution: Ensure that you give unique names to the journal mailbox locations 
on different Domino servers, if the locations are to be archived by a single 
Enterprise Vault server.

Troubleshooting report export
This section describes how to troubleshoot problems that may occur when you 
export reports.

CSV format: All data appears in a single cell in Excel
Problem: Reports exported in CSV format are rendered by default in Unicode, 
which results in Excel displaying all data in a single cell.

Resolution: To resolve this problem:

1 Open the following configuration file for editing on the Report Server:

<SQL_Server_Install_Path>\Reporting 
Services\ReportServer\RSReportServer.config

2 Locate the following Extension tag for the CSV renderer:

<Extension Name=”CSV”> </Extension>

3 Change this tag so that its content is as follows:

<Extension Name=”CSV” Type="Microsoft.ReportingServices.Rendering.
CsvRenderer.CsvReport,Microsoft.ReportingServices.CsvRendering"> 
<Configuration><DeviceInfo><Encoding>ASCII</Encoding></DeviceInfo>
</Configuration></Extension>

Excel format: Date and time stamp does not appear
Problem: In a report exported in Excel format, the date and time details do not 
appear in Excel’s Normal layout (although they are correctly shown in the footer 
of printed reports).

Resolution: To view the date and time from Excel, select the File > Page Setup > 
Header/Footer tab, or select File > Print Preview.

Web Archive format: Images truncated
Problem: Images can appear truncated in a report exported in Web Archive 
(MHTML) format.

Affected configurations: Microsoft SQL Server 2000 Reporting Services
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Resolution: This problem only happens on the first time in a session when you 
export the report. To work around the problem, export the report again. 
Alternatively, save the exported file to disk and then open the saved file using 
Internet Explorer.

XML file format: “Page cannot be displayed” error
Problem: If you export an Asian language operating system report in XML file 
format and opt to open the file rather than save it, you may receive the error 
“Page cannot be displayed”.

Cause: This problem occurs when the report name contains double-byte 
character set (DBCS) characters or special characters such as a hyphen. It occurs 
because Internet Explorer applies URL encoding rules to create a temporary file 
name, but Report Manager attempts to show the exported XML file name 
without applying URL encoding.

Resolution: To work around this problem, save the file before viewing it. 
Alternatively, identify the location of the temporary XML file by observing the 
URL displayed in the Web browser when the “Page cannot be displayed” error is 
shown. Then go to the temporary file location and open the file in Internet 
Explorer.

Known Issues
The following are known issues relating to report export:

DBCS characters unreadable in PDF format
Double byte character set (DBCS) characters may fail to display correctly in a 
report that is exported in PDF format. 

Archive quota usage report: Problems when exported in CSV 
or XML format
The following problems may affect the Archive quota usage report: 

■ When exported in CSV format, the report may display the error: 
Subreport could not be displayed.

■ When exported in XML format, the report may contain information for all 
users in addition to the selected user.

This issue is related to the Microsoft Reporting Services rendering extensions, 
which do not render complex reports correctly.
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CSV and XML format Data Analysis reports omit table header 
information
If you export a Data Analysis report in CSV format or XML format, the report’s 
table column header information may be missing in the exported report.

Using Reporting with multiple Reporting Services
This note applies to Enterprise Vault 8.0 and later only.

Note the following if you configure Enterprise Vault Reporting on two or more 
computers with different SQL Server Reporting Services.

If both the Reporting Services are associated with the same Enterprise Vault 
Directory database, then the permissions associated with Enterprise Vault's 
administration roles apply to both of the Reporting Services. That is, a user 
account whose role permits access to some reports in one Reporting Services 
can also access the same reports in the other Reporting Services. However, a 
user's actions in one Reporting Services are not reflected in the other. This can 
result in the following scenario:

■ A user account that is assigned the FSA Administrator role accesses the 
Report Server Web application for Reporting Services A. The user 
subscribes to a number of FSA reports and creates a database snapshot.

■ The same user account later accesses the Report Server Web application for 
Reporting Services B. The user then checks for subscribed reports and 
snapshots, but finds no record of the subscriptions or the snapshot that 
relate to Reporting Services A.

To work around this issue, the user must perform the required actions in both of 
the Reporting Services.
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